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1 Introduction 
1.1 About this course 
The objective of this course is to teach you how to apply the AquaSim software for static and dynamic 

analyses of structures. You will be learning fundamental aspects about preprocessing, running analysis and 

postprocessing of results. The course is especially aimed at the aquaculture industry, with focus on modeling 

and analysis of moored systems.  

You will be presented a set of case studies. The complexity of the case studies increases, it is therefore 

recommended to complete them in sequence, starting with CaseStudy 01. 

This course should be viewed as an introduction and supplement to the courses held by Aquastructures, and 

not as a replacement. Aquastructures offer attendance courses and online training for beginners and 

advanced users. Visit us on our website aquasim.no. 

1.2 Knowledge and prerequisites 
The course is designed so that you do not need prior knowledge of the AquaSim software. It is expected that 

you are confident within data processing (MS Excel and similar), and have basic skills in the following: 

- Mechanics 

- Knowledge of principles of hydrodynamic 

- Knowledge of principles of Finite Element Method and analysis. 

To start the course, it is assumed that the AquaSim package is installed locally on your computer. 

1.3 Training files 
The complete collection of files from this course is found in your AquaSim folder on your computer. 

 

Figure 1 

1.4 Conventions and fonts in this course 
Conventions and fonts applied in this course are described in the table below. 

Convention Description 

> (greater than) Meaning the next step in your selection procedure. Example: Right click node > 

Nodes > Pointload. 

Consolas Is applied for commands and options. Example: Right click component > 

Type > Beam. 

Oxygen Is applied for headings that separates the main steps in each course: 

introduction, preprocessing, calculation and postprocessing 

Trade Gothic Next 
Light 

Indicates names, folders and files. 
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1.5 What is AquaSim? 
AquaSim is an analysis tool developed by Aquastructures. The software is based on the calculation method 

Finite Element Method (FEM). It is applied for structural analysis of marine- and land-based structures.  

The AquaSim package provides a complete solution from preprocessing with drawing and specification of 

material properties, calculations of response due to environmental loads, to postprocessing and presentation 

of results.  

AquaSim is based on time domain analysis, meaning it accounts for time-varying loads. 

1.6 What is Finite Element Method? 
Finite Element Method (FEM) is a numerical technique for solving of partial differential equations. FEM is 

based on subdividing a structure into a discrete number of smaller elements. This is done through 

discretization. Simple equations are established for each element and assembled into larger systems of 

equations to solve the problem. Fundamentals of the Finite Element Method in AquaSim is found in the 

AuqaSim Package Theory User Manual https://aquasim.no/resources/documentation.html. 

1.7 The AquaSim package 
AquaSim consist of three modules: 

- Preprocessing with use of AquEdit and AquaCross 

- The calculation engine, also known as solver 

- Postprocessing with use of AquaView and AquaTool 

1.7.1 AquaEdit and AquaCross 
AquaEdit is applied for preprocessing and preparation of analysis. The numerical model is established 

through a graphical interface. The components that constitute the model is given properties in terms of 

geometric cross-section, stiffness, weight, and material properties. AquaCross is an add-on in AquaEdit for 

drawing of complex cross-sections. Discretization of your model is done in the preprocessing phase, where 

the model is divided into a discrete number of elements. 

The user interface is set up as most computer aided programs – with symbols and options. In AquaEdit, the 

analysis parameters are defined in terms of environmental loads, time series, result- and export selections.  

 

Figure 2 AquaEdit 
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AquaSim utilize four main component types to resemble structures, these are: 

- TRUSS component: applied for wire, rope, chain and similar structures with circular cross 

sections. Capable of withstanding tensile and compressive loads. 

- BEAM component: applied for structures with more complex cross sections, such as I-beams, 

floating collars, barges and so on. Capable of withstanding axial-, torsional-, and bending loads. 

- MEMBRANE component: applied for rendering of net pens, tarpaulins, shell structures and so 

on.  

- NODE2NODE component: applied for contact forces and similar. This is a component with a 

spring in each end of the discrete element.  

1.7.2 Calculations 
The numerical model is exported to the calculation engine which solves the partial differential equations 

based on the input from AquaEdit.  

1.7.3 AquaView and AquaTool 
The AquaSim package provide two regular postprocessing tools: AquaView and AquaTool. Good 

visualization of the results is important for the understanding and safety of the analyses. AquaView provides 

a 3D presentation of your numerical model along with resulting deformations, forces, and stresses.  

AquaTool give access to the same results as in AquaView, only the presentation is different. AquaTool 

provides results in terms of tables and graphs, useful when handling large datasets.  

 

Figure 3 AquaView 

 

Figure 4 AquaTool 
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1.8 Errors in FEM 
When building and discretizing models, errors may occur. Errors can originate from the model or in the 

calculations. Model errors are typically connected to discretization of the model, properties of components 

or inappropriate boundary conditions. This often leads AquaSim unable to calculate equilibrium between 

internal forces (cross section properties) and external forces (environmental loads), and the calculations tend 

to diverge. It is therefore important prior to building a model, to assess the nature of the problem: what is the 

purpose of your analysis, what are you going to investigate, can the problem be simplified?  

Errors originated from the calculations are often connected to round-off problems from the solver. These 

errors are for most practical purposes very small.  

1.9 Analysis process 
Regardless of the problem investigated, you are going through the same process every time. Problem solving 

in AquaSim may be divided in the following main steps: 

Preprocessing: 

Creating a model: 

The problem is defined, and a model is established in AquaEdit.  

Cross section properties: 

The model components are given cross sectional properties in terms of geometric 

cross-section, stiffness, weight, and material properties. 

   Discretization: 

   Discretization is conducted parallel to establishing the model. 

Boundary conditions: 

Boundary conditions are set mostly in terms of constraints at nodes. Allowing, or 

disallowing, translations, and rotations in 3D space. 

Calculations: 

Analysis parameters are defined prior to export of the model, these are set in terms of 

environmental conditions (wind, current and waves), time domain parameters, result 

selections and export alternatives. The model is exported, and calculations starts. 

Displacements and stresses are calculated.  

Postprocessing: 

Results are assessed in either AquaView or AquaTool.  
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2 Case study 01 – Cantilever beam with force 
2.1 Learning objectives 
Upon completion of this case study, you will be able to: 

- Navigate in AquaEdit 

- Specify properties of beam component 

- Verify model 

- Know basic properties of analysis parameters 

- Establish an analysis folder and run analysis 

- Open, and navigate, in AquaView 

- Assess the influence of model discretization 

2.2 Introduction 
In this case study you will determine the shear force of a cantilever beam with rectangular cross section. The 

beam is exposed to a horizontal point load, giving rise to shear forces.  
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2.3 Preprocessing 
 

1 Load 
preprocessing 
tool  

From the Start menu on your computer search AquaEdit, or double click on AquaEdit 

shortcut from your desktop. The preprocessor AquaEdit will be loaded. 

 

 
 

2 Review 
interface of 
AquaEdit 

In this section, an introduction to the interface of AquaEdit is presented. For more 

detailed information, please see the AquaEdit User Manual found in your installation 

folder Aquastructures\AquaSim\doc or at aquasim.no. 

 

The Toolbar provides quick access to the most common used features: settings for 3D 

view, camera views, drawing intents and export menu.  

 

 
 

 The main view is where the model is created, showing nodes and elements with 

respect to the global coordinate system. 

 

 
 

 The left and right columns in the main view are docking areas for object-, decorator- 

and component property windows. These windows can be dragged and dropped for 

customized views.  
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The Components window provides a list of all the components in your model. 

AquaSim provides four main component types (TRUSS, BEAM, MEMBRANE, 

NODE2NODE) as described in section 1.7.1. Each component represents a collection 

of element properties in your model.  

 

 The lower most toolbar provides access for typing coordinates of nodes and elements 

(useful when you need accurate positioning). Further, coordinates of your mouse 

pointer in the 3D view and tooltips are found here. 

 

 
 

3 Generate 
beam 
component 

You are to establish a BEAM component. In the Components window, AquaEdit by 

default present the first component as type TRUSS. To change this, right click  

1 Component > Type, select BEAM. 

 

 
 

4 Draw beam 
Select the intent Draw line  from the Toolbar menu. Move the mouse pointer 

down to the lower most toolbar to type the coordinates of the first node, X=0 Y=0 

Z=0 , press ENTER on your keyboard.  

 

Now, select the checkbox to the right of coordinate Z. This will activate relative 

coordinates to the first defined node, type X=0 Y=0 Z=-20 

, press ENTER on your keyboard. Then, exit the 

Draw line intent by selecting Pointer, or press ESC three times. You should now 

have one element connected with two nodes, in your 3D viewer. 
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5 Properties of 
Beam 
component 

You should give the beam cross sectional properties by accessing the Edit beam 

window. Note that the component name is in italic, this indicates that it lacks 

essential properties for analyzes to be performed. Right click 1 Beam > Edit.  

 

 
 In the Edit beam window, the first view you meet is the Information-tab. In the 

Information-tab you may assign general information to your beam and either draw a 

cross section from predefined sections or access AquaCross for customized sections. 

In the row Name, type the component name Beam.  

 

 
 

Press the drop-down menu from Data source > Massive rectangular. 

 

 



 

aquastructures 
 

Page 12 of 133 

 

The wizard dialogue for predefined sections is opened. Change Material from 

Plastic to Steel. Press OK, and then OK in the Edit beam window. 

 

 
 

 The name of the component should have changed from italic to straight font, meaning 

the beam has adequate properties.  

 

 
 

6 Save the 
model 

Good saving routines during modelling is important to ensure that work is not lost. In 

the top menu, select File > Save as… 
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Navigate through the File Explorer to a suitable place to save your model. In this case 

study, we have created a folder in Documents\AquaSim called 

Analyses\CaseStudy01. Assign model name Beam and press Save. 

 

7 Assign 
boundary 
conditions 

The cantilevered beam should be restrained from translation and rotation at the top 

end and exposed to a point load in x-direction at the lower end.  

 

In the 3D view, use the mouse pointer and click on the node in the origin of the 

global coordinate system. The Nodes property window will be activated in your left 

docking area. In the row DOF (Degrees Of Freedom), select all the checkboxes. 

 

 
 

In the DOF row (counted from left to right): the first three checkboxes represent 

translation about x-, y- and z-axis respectively. The three last checkboxes represent 

rotation about x-, y- and z-axis respectively. One selection represents a constraint, so 

when all the checkboxes are selected the node is restrained in all Degrees Of 

Freedom. Having one or more restraints, the node in the 3D view will change from 

black to blue. 

 

8 Assign point 
load 

The point load is to be assigned to the free end of the beam. In the 3D view, use the 

mouse pointer to select the free end of the beam. Right click > Nodes > 

Pointload > Create new. 

 

 



 

aquastructures 
 

Page 14 of 133 

 

 In the Pointload window, type Force X=1000. The directions for force and 

momentum are applied with respect to the global coordinate system. A positive value 

in x-direction correspond to a force acting in the positive x-direction. Click OK. 

 

 
 

 The Decorators window in the docking area to the right lists the node decorators in 

the model. In addition to Pointload, nodes may have decorators such as impulse load, 

spring, shape and more.  

 

In the 3D view, the node with the Pointload change color from black to red. In 

addition, the arrow indicates the direction of the applied load. 

 

 
 

9 Verify model The model is complete. To verify the model is correct and without errors, select 

Commands > Verify model. If the model has errors, AquaSim will suggest 

solution to fix it. Read more about errors and warnings in the AquaEdit User Manual. 
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2.4 Calculations 
 

10 Enter 
Environment 
window 

Now that you have a complete model without errors, the next phase is to prepare the 

analysis. Before analysis can start, export parameters must be defined. In the Toolbar 

menu, select Export .  

 

 
 

The Environment window is opened. Here, parameters for environmental loads (wave 

height, current and wind) are defined. In addition, analysis parameters such as 

discretization of water surface, configuration of seabed, type of results to be reported 

and so on is set. 

 

11 Environmental 
loads 

In the upper part of the Environment window parameters for environmental data is 

defined. AquaSim is based on analysis where the user defines sets with combination 

of wind, current and waves. These sets are referred to as load conditions or sea states. 

Details of this will be discussed later in this course. 

 

12 Time serie 
parameters 

AquaSim apply static and dynamic loads in incremental steps. This is to ensure a 

stable analysis and that a numerical solution is found. Static-, (quasi)static and 

dynamic loads are applied in order: 

Static loads: static equilibrium is calculated between internal and external 

loads. Examples: weight, buoyancy, hydrostatic pressure, point loads. 

(Quasi)static loads: are applied gradually in a predefined number of steps, 

until it is fully developed. These steps are defined in Preincrement. 

Examples: current and regular wind. 

Dynamic loads: are applied on top of the static and (quasi)static loads, 

following the same principle with gradually increasing loads. These steps are 

defined in Num total steps for waves and Num steps for one 
wave. Examples: regular- and irregular waves and wind.  
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You are to conduct a static analysis, so Preincrement is the parameter to define. In the 

row Preincrement, type 5. In the row Num total steps for waves, type 0. 

 

 
 

 

13 Export 
selections 

In the lower right corner of the Environment window, export selections are available. 

Here you may choose what types of files to be generated/ deleted upon export, 

priority and grouping of analysis and selection of available solver versions. Make the 

same selections as in the figure below. 

 

 
 

Select Export.  

 

You must decide for where you want to save the analysis. Navigate to an appropriate 

place on your computer. In this case study, we have created an analysis folder in 

Documents\AquaSim\Analyses\CaseStudy01 called Static01. Type an analysis 

name e.g., static01_.  

 

 
 

Select Export. 
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14 Run analysis Upon selecting Export, you will be presented with an analysis window. To start the 

analysis, press Start or Start all. 

 

 
 

The progress of the analysis is shown with a green bar moving from left to right. 

When the analysis is finished, the analysis window will have status finished. You 

have now successfully completed the analysis. 
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2.5 Postprocessing 
 

15 Open result 
file 

In the Analyse window, select Open. This will load the postprocessing tool 

AquaView. The model is presented in a 3D view as it was built in AquaEdit. 

 

 
 

The blue square seen in the 3D view, is the water surface. This is adjustable in size 

and transparency. 

 

16 Review 
interface of 
AquaView 

In this section, an introduction to the interface of AquaView is presented. For more 

detailed information, please see the AquaView User Manual found in your 

installation folder Aquastructures\AquaSim\doc or at aquasim.no. The top Toolbar 

menu provides access to view analysis results, camera views and tools.  

 

 
 

The main view is where the model is presented with results in time-domain. Several 

blue bars are seen to the left, right and above the main view: 

- Left side: controls the Graphic color palette. By click and drag, the color 

rendering of results in the main view is adjusted. 

- Right side: controls the visual size of the nodes for a selected element in 

the model. 

- Top: controls the transparency of the water surface. 
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 At the lower most part of AquaView, you find the playback controls. It enables for 

continuous playback of the analysis, as well as choosing specific timesteps. Options 

for recording of videos and screen shots are also found here. 

 

 
 

 

17 Water surface You should adjust the size of the water surface. From the top Toolbar menu, select 

Tools > Water surface > Set water surface. 

 

       
 

In the Set water surface window type X-min=-10 Y-min=-10 X-max=20 Y-
max=20. Select OK. 

 

The size of the water surface is updated. 

 

 
 

18 Plot shear 
force 

From the top Toolbar menu select Result > Local section forces > Shear 
force Z [N]. You should see the shear force in z-direction for the beam in the 3D 

view. By pressing  the results from time domain analysis are played. Observe how 

the beam deform and the colors change as a function of analysis steps. 
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Step 1 is results from calculation of static equilibrium between internal force in the 

beam (weight, buoyancy) and the external force from the point load. Step 2-5 are 

identical to the results in step 1, this is due to only static forces are defined prior to 

calculation. (Quasi)static loads (current, regular wind) are not included in the 

analysis. 

 

19 Graphing 
results for 
element 

The results may also be presented in a graph as a function of analysis steps. Use your 

mouse pointer and right click on the beam element in the 3D view. The Element 

result window will appear, presenting the results both as a table and in a graph.  

 

 
 

As mentioned earlier, each element is connected by two nodes. In the Element result 

window, results are presented for node A (the first node of the element) and node B 

(the second node of the element). By selecting the checkbox B, shear force for the 

free end is presented. Take note of the maximum shear force at node B is 980.0 N at 

step number 5.  

 

This section is now completed, close the Analyse window. 
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2.6 Discretization 
 

20 Discretization One important aspect was not considered when the model was established in 

AquaEdit: discretization. In this section, you are going to see the effect of 

discretization of the model on analysis results.  

 

Go back to your model in AquaEdit or chose the premade model from 

Documents\AquaSim\Demoes\CaseStudy_01\CaseStudy01.amodel. The 

premade model is loaded in AquaEdit by double click on the file. 

 

You should divide the element into smaller entities. From the intents in the Toolbar 

menu, select Split line . The Tool properties window is activated in the left 

docking area, with settings for splitting of elements. In the row Number of 

elements, type 10 and press ENTER (alternatively select the arrow  until you get 

10).  

 

 
 

Move the mouse pointer to the 3D view until it is situated above the beam element, 

then left click. 

 

 Your beam should now consist of 10 elements. 

 

 
 

All the elements that constitute your beam shear the same properties because they are 

grouped within the same component Beam. 
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21 Visual cross 
section 

Until now, your beam is just presented as a straight line in the 3D view. From step 

number 5 in this case study, you remember the beam was assigned a visual cross 

section. To turn on the display of the cross section, select  from the 

Toolbar. Then, zoom into the beam by Scrolling upwards.  

 

 
 

22 Enter 
Environment 
window 

The model is now ready for analysis. Access the Environment window by selecting 

Export  from the Toolbar. Leave the Time serie parameters and Export 

selections as described in section 2.4. 

 

 
 

23 Export 
selections 

In the Environment window, select Export. Create a new folder for analysis. In this 

case study, we have created an analysis folder in 

Documents\AquaSim\Analyses\CaseStudy01 called Static02. Give the analysis a 

name e.g., static02_.  

 

 
 

Select Export. 
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24 Run analysis The Analysis window appears. To start the analysis, press Start or Start all. 

 

 
 

When the analysis changes the status from waiting to finished, select Open in 

the Analysis window. AquaView should be loaded. 

 

25 Plot shear 
force 

From the top Toolbar menu in AquaView, select Result > Local section 
forces > Shear force Z [N]. Jump to the last analysis step by selecting  from 

the Playback control in the lower left corner of AquaView. Adjust the transparency of 

the water surface by dragging the blue bar in the top of the 3D view to the left. 

 

 
 

You may observe that the color of the beam is different for the first analysis.  
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 Use your mouse pointer and right click on the free end of the beam in the 3D 

view. The Element result window will appear, presenting the results both as a table 

and a graph. 

 

 
 

By selecting node B, the shear force for the free end is presented. Take note of the 

maximum value at node B is 996.99 N at step number 5.  

 

26 Comparing 
results and 
summary 

By comparing the two analyses static01_ and static02_ it is seen that the 

discretization affects the results. Both color rendering and the magnitude of the shear 

force is affected. 

 

 
 

Model  Shear force Z [N] 

1 element (Static01_) 980.0 

10 elements (Static02_) 996.99 

 

You can experience smaller differences between your own results, and the one 

presented here. This may be due to different solver versions being applied. We see 

that the shear force increases with more elements in the model. This is because the 

beam becomes less stiff with increased number of elements. 

 

This case study is now finished.  
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2.7 Summary 
We modelled a simple beam to introduce the AquaSim interface and analysis functionality. A static analysis 

was conducted with two different discretization of the model: one with 1 element and the second with 10 

elements.  

We have seen that the number of elements in the beam affect results from the analysis, it becomes more 

accurate with more elements. If you had divided the beam into more than 10 elements, you might see the 

shear force increase slightly more.  

At some point you will see that further increase of elements in the model will not affect the results; it 

converges to a final value. However, the more elements your model contain, the more comprehensive and 

time-consuming the calculations becomes.  
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3 Case study 02 – Winch system 
3.1 Learning objectives 
Upon completion of this case study, you will be able to: 

- Assemble a model with different component groups 

- Specify properties of TRUSS and BEAM elements 

- Establish winch as node decorator 

- Add built-in shape to node 

- Verify model input through static analysis 

- Execute static analysis 

- Execute multiple non-linear dynamic analyses 

- Copy results from AquaView to Excel 

3.2 Introduction 
In this case study you will establish a system consisting of wire, beam, and winch. The wire is winching the 

beam from air through the water surface. You are going to assess the forces in the wire for two combinations 

of environmental loads (also referred to as load conditions). Before dynamic analysis is conducted, the 

weight of the system should be controlled through a static analysis.  
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3.3 Preprocessing 
 

1 Load AquaEdit As you learned from the previous case study, AquaEdit is the preprocessing tool, and 

where the analysis parameters are defined prior to export. From the Start menu on 

your computer, search, and load AquaEdit. 

 

 
 

The grid in the 3D view can be toggled on an off by selecting  from the Toolbar 

menu.  

 

2 Create 
component 
groups 

In this case study you will need two component groups: one for the wire and one for 

the beam structure. In the Components window, select New component.  

 

 
 

 The wire should be of component type TRUSS, and the beam should be type BEAM. 

Component type TRUSS is a structural element capable of only resisting tensile and 

compressive forces. Since a wire is flexible and bend easily, TRUSS is selected. The 

beam in the end of the winch system, is intended to be stiff, resisting both axial- and 

bending forces. Therefore, the BEAM is selected.  

 

By default, AquaSim generate new components of type TRUSS. You need to change 

one of the component types. In the Components window, right click 

Component 2 > Type > BEAM. 
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Note that when changing component type to BEAM, Component 2 jumps to the top 

of the list. AquaSim order the component types with BEAM at the top, then 

MEMBRANE, TRUSS and last NODE2NODE. 

 

3 Component 
properties 

The wire and beam have cross sectional properties as specified in the table below. 

 

Properties of wire Value 

E-modulus 1.0E+11 N/m2 

Area 2.83E-03 m 

Weight in air 5.3 kg/m 

Diameter 0.03 m 

  

Properties of beam Value 

Length x Width 1000 mm x 1000 mm 

Density 1200 kg/m3 

E-modulus 2.1E+11 N/m2 

G-modulus 8.08E+10 N/m2 

Poisson’s number 0.29 - 

Weight in air 1200.0 kg/m 

 

In the Components window, double click Component 1 to access the Edit truss 

window. 
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 Give the component a suitable name, we have called it Wire. Type the information 

from the table in the Edit truss window. 

 

 
 

Select OK. 

 

In the Components window, double click Component 2 to access the Edit beam 

window. In the row Name, give the component a suitable name. We have chosen 

Beam. The row Type provides a dropdown menu for selection of load formulation. 

A load formulation is a set of differential equations for calculation of external loads 

on the component. Morison submerged calculates the loads based on Morison 

equation. Hydrodynamic calculates the loads based on strip theory in combination 

with Morison equation. Choose Morison submerged. 

 

From the drop-down menu in Data source select Massive rectangular.  
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The Wizard dialogue for cross sections will be loaded. In the section for Material 
properties, select <Custom> from the Material list. Type the values provided 

for density, E-modulus, G-modulus and Poisson’s number. In the Geometry 
properties section, type the dimensions of the cross section. 

 

 
 

Select OK. 

 

 A preview of the visual cross section is found in the lower part of the Information 

tab. It is possible to edit this by manually typing coordinates of the cross section and 

move it up or down with respect to the local coordinate system. This will not affect 

the calculated cross section parameters as specified in the Wizard dialogue. 

 

 
 

One parameter is remaining for the beam: the weight in air. Select the Material / 
section parameters-tab to the left in the Edit beam window. Here, cross 

sectional parameters for the beam are presented. Navigate to the row Weight in 
air and make sure it says 1200.0 kg/m.  

 

 
 

Select OK in the Edit beam window. 
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Notice the name of the component is changed from Component 2 to Beam, and that 

the font is changed from italic to straight. Indicating the component has necessary 

properties for analysis to be conducted.  

 

 
 

4 Winch system, 
drawing 

The winch system should have the dimensions as described in the figure below. 

 

 
 

You are first to model the beam, then the wire. 

 

5 Draw beam When drawing structures, the current component must first be activated. Activate the 

beam component by left click on 1 Beam in the Components window.  

 
 

From the Toolbar menu, select the intent Draw rectangle . Move the mouse 

pointer down to the lower most toolbar to type the coordinates of the first node,  

X=-10 Y=10 Z=6 , press ENTER on your 

keyboard. Select the checkbox to the right of coordinate Z. This will activate relative 

coordinates to the first defined node, type X=20 Y=0 Z=0 

, press ENTER on your keyboard. For coordinates 

of the last node, type X=0 Y=-20 Z=0 , press 

ENTER on your keyboard. 
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The color of the 1 Beam can be changed by left click on the brown rectangle in 

the Components window. We have chosen blue. 

 

 
 

Select OK. 

 

 

6 Draw wire Activate the wire-component by left click on 2 Wire in the Components window. 

 

 
 

From the Toolbar menu, select the intent Draw line . Move the mouse pointer 

down to the lower most toolbar to type the coordinates of the first node, 

X=0 Y=0 Z=25 , press ENTER on your keyboard. 

For the next node, make sure the checkbox for relative coordinates is still activated. 

Type X=0 Y=0 Z=-11 , press ENTER on your 

keyboard. To exit the Draw line intent, select Pointer  or press ESC three times. 

 



 

aquastructures 
 

Page 33 of 133 

 

 
 

To draw the wire legs, select Draw line  and activate Snap . The snap 

function forces the selected intent to snap to the node closest to your mouse pointer. 

Move your mouse pointer to node number 1 (as indicated in the figure below) and 

left click.  

 

 
 

The black line between Node 1 and Node 2 is a preview of the drawn line. Move the 

mouse pointer to Node 2 and left click on it. To escape the continuous line press 

ESC once. Then reselect Node 1 and move your mouse pointer to Node 3 and left 
click on it.  
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Repeat this for Node 4 and Node 5. When finished, select Pointer to escape the 

Draw line intent. The result should look like the figure below.  
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7 Model winch A winch is applied to one end of an element. Select the vertical wire element in the 

3D view by left click > Elements > Winch > Add winch. 

 

 
 

The Edit winch window opens. The winch can either winch out or in, this is selected 

from the drop-down menu of Winch type. The velocity of winching in or out is in 

m/s. When winching out, AquaSim adds elements, and in Segments you can specify 

how many elements AquaSim should add. The selection Reversed allows to change 

which node the winch should be placed. 

 

The winch type should be Out. Type winch velocity 1.0 m/s, and number of 

segments should be 1. By default, AquaSim places the winch at the second generated 

node of an element. You want to place the winch at the node with position z=25m. 

Since you started drawing the winch from the top, the second node of the element is 

situated at z=6m. To place the winch at the top node, activate Reversed by left 
click the checkbox. Then, activate a winch shape by selecting the Shape active 
checkbox. 

 

 
 

Select OK.  
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The modelled winch is available in the Decorators window in the right docking area.  

 

 
 

In the 3D view, the winch is visible as a green cylinder. 

 

 
 

If you cannot see the green cylinder, turn on the display of shapes by selecting  

in the Toolbar menu. If the winch has not ended up in the correct node, double click 

on Winch 1 in the Decorators window to reopen the Edit winch window. Make a 

selection in the row Reversed, then select OK. 

 

8 Save the 
model 

Make sure to save the model, to reduce risk of loosing data. In the top menu, select 

File > Save as… 

 

 
 

Navigate through the File Explorer to a suitable place to save the model. We have 

chosen the folder Documents\AquaSim\Analyses\CaseStudy02. Assign the model 

name Winch and press Save. 
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9 Assign 
boundary 
conditions 

The wire should be restrained from translation and rotation at the winch. In the 3D 

view, select the node with the winch by left click on the node. Go to the Nodes 

window in the left docking area, select all checkboxes in the row DOF. 

 

 
 

 

10 Discretization Your model is to be discretized. From the Toolbar menu, select the intent 

Split line . The Tool properties window is activated in the left docking area. 

In the row Number of elements, type 4 and press ENTER on your keyboard 

(alternatively select the upper arrow  until you get 4). 

 

 
 

Move the mouse pointer to the 3D view to the vertical part of the wire, apply the 

Split element by left click on the element once. Repeat this for all elements 

in the model. 
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Be aware that if you left click an element more than once, AquaSim continue to 

divide the elements. If this happens, press CRT + z on your keyboard, or Edit > 

Undo Split Element(s) Ctrl+z. 

 

 
 

 

11 Verify model The model is now complete. To verify that the model is correct and without errors, 

select Commands > Verify model. 

 

 
 

A complete model without errors is created, the next phase is to prepare the analysis. 
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3.4 Calculations static analysis 
 

10 Enter 
Environmental 
window 

Before analysis can start, export parameters must be defined. In the Toolbar menu, 

enter the Environmental window by selecting Export . 

 

11 Time series 
parameters 

Before a dynamic analysis is conducted, you are going to control the weight of the 

system through a static analysis. The weight of the system is controlled by consider 

the axial force in the wire.  

 

In the section for time series, type Num total steps for waves= 0. This will 

leave only the static part of the analysis to be run. The static analysis will be 

conducted in 5 steps, as given in Preincrement. Make sure other settings are 

equivalent to the figure below. 

 

 
 

In the section Advanced, navigate to Water volume correction, select the 

drop-down menu and choose With slamming.  

 

 
 

The Water volume correction is a feature for selecting how AquaSim should correct 

the calculation of hydrodynamic properties of elements when they move in and out of 

water. Choosing With slamming, AquaSim will identify if BEAM elements with load 

formulation Morison submerged, are above or below the water surface. 

Hydrodynamic properties will be adjusted and updated for each analysis step. To get 

more insight in the different options for Water volume correction, please see the 

Theory Manual section Water volume correction. 
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 Select Export in the lower right corner of the Environmental window. Decide for 

where you to save the analysis. Navigate to an appropriate place on your computer. In 

this case study, we have created an analysis folder in 

Documents\AquaSim\Analyses\CaseStudy02 called Static. Type an analysis name 

e.g., static_. 

 

 
 

Select Export. 

 

12 Run analysis The Analysis window appears, select Start or Start all. 

 

 
 

When the progress status in the Analysis window change to finished, and a green 

box appears the left of the status, the analysis is successfully completed without 

errors. 
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3.5 Postprocessing static analysis 
 

13 Open result 
file 

In the Analysis window, select Open. This will load the postprocessing tool 

AquaView. 

 

 
 

 

14 Plot axial 
force in wire 

From the top Toolbar menu, select Result > Local section forces > Axial 
force [N]. 

 

 
 

The axial force in the wire connection point is found by left click on the element 

between the two green spheres as indicated in the figure below.  
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Take note that the axial force in the element, at the lower most node (node B in our 

example), is 9.452E+05 N. 

 

 
 

This should correspond to the total weight of beam and wire in air.  
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15 Compare 
results with 
hand 
calculations 

From the input table presented in section 3.3 we know the weight per meter for both 

wire and beam. You need to find the total length of each element. There are several 

ways to do so, one method is presented below. 

 

From the top Toolbar menu, select Tools > Show component lengths. The 

Length of components window opens. 

 

 
 

The total mass of the components in air is calculated as: 

𝑚𝑡𝑜𝑡𝑎𝑙 = 𝑚𝑤𝑖𝑟𝑒 + 𝑚𝑏𝑒𝑎𝑚 = 5.3
𝑘𝑔

𝑚
∙ 78.744𝑚 + 1200

𝑘𝑔

𝑚
∙ 80𝑚 = 96417.3𝑘𝑔 

Converting this to Newton, we get the force due to gravity: 

96417.3𝑘𝑔 ∙
9.81𝑚

𝑠2
= 9.459𝐸 + 05 𝑁 

Hand calculations are compared in the table below: 

 

AquaView [N] Hand calculations [N] Difference [N] 

9.452E+05 9.459E+05 -0.07 % 

 

The differences are considered neglectable small. We now know that AquaSim 

calculates the weight and axial force correctly.  

 

Exit AquaView and close the Analyse window. 
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3.6 Calculations dynamic analysis 
 

16 Enter 
Environmental 
window 

You should investigate the response of the beam when it moves through the water 

surface for two different combinations of environmental loads. Each combination of 

environmental loads is referred to as a load condition (LC), or sea state. 

 

Go back to the model in AquaEdit. If you have exited the program, the model can be 

reopened by doble click on the Winch.amodel from the File explorer, AquaEdit 

will then be loaded.  

 

From the Toolbar menu, enter the Environmental window by selecting Export 

. 

 

17 Load 
conditions 

In the upper part of the Environmental window you find the parameters for the 

environmental loads. Each line represents one load condition. The input values for 

the load conditions are described in the table below. 

 
Nr Amp [m] T [s] V [deg] cX 

[m/s] 

cY 

[m/s] 

wX 

[m/s] 

wY 

[m/s] 
Row 

number 

of the 

LC 

Wave 

amplitude 

(𝜁𝐴) 

Wave 

period 

Direction the 

wave 

propagates. 

A value of 0 

correspond 

to along 

positive x-

axis. 

Current 

velocity 

along x-

axis. 

Current 

velocity 

along y-

axis. 

Wind 

velocity 

along x-

axis. 

Wind 

velocity 

along y-

axis. 

1 0.5 3 0 0.5 0 0 10 

2 0.5 8 0 0.5 0 0 0 

 

Type the values from row no. 1 in equivalent place in the Environmental window. 

 

 
 

To add load condition no. 2, select Add and type the values in appropriate sections. 
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When this is done, select Save. The Add new load window will close, and a new row 

has been added to the list. 

 

 
 

18 Time series 
parameters 

To conduct a dynamic analysis, type the parameters as presented in the Time serie 

section below. 

 

 
 

When Num total for waves = 80 and Num steps for one wave = 20, 

AquaSim will conduct the analysis over 80/20 = 4 wave cycles in addition to the 5 

preincremental steps. Make sure With slamming is activated as Water volume 

correction in the Advanced section. 
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19 Export 
selections 

In the export selection section, apply the selections as provided in the figure below. 

 

 
 

 Select Export. Navigate to an appropriate place on your computer where you want 

to save the analysis. In this case study, we have chosen 

Documents\AquaSim\Analyses\CaseStudy02 and created a folder Dynamic. Type 

an analysis name e.g, dynamic_. 

 

 
 

Select Export. 

 

20 Run analysis In the Analysis window you will see the load conditions ready to be analyzed. To run 

the analysis of both load conditions parallel, select Start all. 

 

 
 

The analysis is finished when both load conditions change the status to finished. 

Depending on your computer, this analysis should be finished within approximate 10-

15 seconds. 
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3.7 Postprocessing dynamic analysis 
 

21 Open result 
file, load 
condition 01 

In the Analysis window, select Open for the load condition called dynamic_01.  

 

If your analysis is not completed, or an error occur, you may load the equivalent file 

found in AquaSim\Demoes\CaseStudy02\Dynamic. In this folder, double click 

dynamic_01.avz, AquaView should be loaded. 

 

 

 

22 Axial force in 
wire 

You should observe how the axial force in the wire changes as the beam is lowered 

from air, through the water surface and below. From the top Toolbar menu in 

AquaView, select Result > Local section force > Axial force [N]. To 

get a better view of the lowering process, select Front  from the top Toolbar 

menu. 

 

 
 

To view the axial force in the connection point of the wire right click on the 

element as indicated in the figure above. Select Play from the playback area in the 

lower left corner. 
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Observe how the axial force is more or less constant as long as the beam is in air. 

When the beam crosses the water surface a significant drop in the axial force is seen. 

This is due to buoyancy in the beam and damping effects from the water. Buoyancy 

is a force acting in the opposite direction of gravity forces, causing the load in the 

wire to be reduced.  

 

By selecting j from your keyboard, you will be provided with the maximum axial 

force in the components for the entire analysis. Which timestep the maximum axial 

force occur is also provided.  

 

 
 

23 Open result 
file, load 
condition 02 

Navigate back to the Analysis window and open the result file for load condition 02 

by selecting Open next to dynamic_02. 

24 Axial force in 
wire 

To view axial force in the wire, select Result > Local section forces > 

Axial force [N]. Select the same element as in load condition 01 by right click 

on the element as indicated in the figure below. 

 

 
 

25 Comparison 
results 

You should now extract the results from the selected element in AquaView to a 

calculation program after your preferences. In this case study, we have chosen MS 

Excel. 

 

In the Element result window for load condition dynamic_01.avz, select Copy all 

to clipboard , the Copy settings window will open. 
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Select Copy to clipboard. Open the calculation program and paste by selecting 

Ctrl + v. 

 

Repeat this for the same element in dynamic_02.avz, paste the results in the 

calculation program next to the results from dynamic_01.avz. 

 

 
 

Create a scatter plot of both result sets. Comparing axial forces between the two load 

conditions, it is seen that the magnitude is more or less similar. Before the beam cross 

the water surface, axial force is equivalent to gravitational forces of the system. 

When the beam crosses the water surface, the axial force drops to about 2.0E+05 N.  

 

 
 

However, dynamic_01 has a more gradual decrease of axial force, and the drop occur 

at a later step than dynamic_02. This is due to the different wave periods in the load 

conditions. The wire is defined to winch out with a constant rate of speed. Since both 

load conditions are defined to be analyzed with the same number of analysis steps 

(Preincrement + Number total for waves = 5+ 80) the beam will pass the 

water surface at different analysis steps. 

 

Dynamic considerations are now finished. Exit AquaView and AquaEdit. 
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3.8 Summary 
We modelled a system with wire, beam, and winch to introduce the feature Winch in AquaSim. This 

required that two component groups were established.  

A static analysis was conducted to control the weight of the system. Then two dynamic load conditions were 

established, and parallel analysis were conducted. The axial force in the wire was extracted from AquaView 

to MS Excel to compare the results.  
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4 Case study 03 – Aquaculture cage and mooring 
4.1 Learning objectives 
Upon completion of this case study, you will be able to: 

- Duplicate model components 

- Model mooring components 

- Mirror model components 

- Model and specify properties of buoys 

- Load bathymetric bottom (terrain) 

- Snap nodes to terrain 

- Apply the component library 

- Execute static analysis 

- Execute multiple non-linear dynamic analyses 

- Have knowledge about system files 

- Assess maximum forces in mooring components from analyses 

4.2 Introduction 
In this case study, you are to complete a model of an aquaculture facility and conduct a mooring analysis. 

You will first be introduced to the main components of the facility, then complete the model by adding 

mooring components and terrain. Through the snap function, the bottom chain is to be lowered to the bottom 

providing realistic representation of interaction between mooring components and the seabed.  

By a static analysis selected parameter, as mooring rope tension and buoyancy, should be checked.  

Having conducted dynamic analysis, you are to find the maximum force in selected mooring components 

from these analyses.  

 

  



 

aquastructures 
 

Page 52 of 133 

 

4.3 Main components of aquaculture facility 
Most aquaculture facilities consist of an enclosure, permeable or impermeable, connected to a floating unit 

in the waterline. The classical facility is equipped with a permeable net pen and a floating collar as the 

floating unit. Together these are referred to as cages. The figure below shows a single cage situated in a 

frame mooring system. In each corner of the frame, buoys are attached providing buoyancy to the frame and 

ease access to components during maintenance. Technical data of the components are described in the table 

below.  

 

 

Component number Description Technical data* 

1 Inner floating pipe of floating collar PE100, Ø400, SDR16.7, CIR120m 

2 Outer floating pipe of floating collar PE100, Ø400, SDR16.7 

3 Bracket, for positioning of floating 

pipes 

PE100, L0.4m, W0.1m 

4 Railing post PE100, Ø160 SDR11 

5 Railing PE100, Ø140, SDR11 

6 Suspension ring for net pen PE100, Ø250, SDR11 

7 Net pen Sn15.4% 

8 Net collector rope 20mm 

9 Reinforcement rope 12mm 

10 Frame rope 64mm 

11 Bridle rope 48mm 

12 Mooring rope 64mm 

13 Bottom chain 32mm 

14 Buoy L1.0m, W1.0m 

* Abbreviations: PE=polyethylene, Ø=pipe diameter, SDR=pipe diameter/wall thickness, 

CIR=circumference, Sn=solidity, D=depth, L=length, W=width.  
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4.4 Preprocessing 
 

1 Open model Open CaseStudy03.amodel from Documents\AquaSim\Demoes\CaseStudy03.  

 

 
 

The model contains an aquaculture cage, and you are to model and add properties to 

the mooring components. This includes Frame rope, Brindle rope, Mooring rope, 

Bottom chain, and Buoys for positioning of the frame rope. 

 

2 Create 
component 
groups 

Create four new component groups by selecting New component from the 

Components window, one for each mooring component. 

 

 
 

The new component groups are by default added as TRUSS with names Component 
10 to Component 13. The ropes and chain are considered as flexible components, 

only capable of taking axial forces. Component type should then be TRUSS.  
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3 Component 
properties 

Properties of the mooring components are presented below. 

 

Properties of Frame rope Value 

E-modulus 2.1E+09 N/mm2 

Area 3.22E-03 m2 

Weight in air 1.85 kg/m 

Weight in water 0.188 kg/m 

Diameter 64 mm 

Drag coefficient 1.2 

Added mass coefficient 1.0 

  

Properties of Bridle rope Value 

E-modulus 2.1E+09 N/m2 

Area 1.81E-03 m2 

Weight in air 1.95 kg/m 

Diameter 48 mm 

Drag coefficient 1.2 

Added mass coefficient 1.0 

  

Properties of Mooring rope Value 

E-modulus 2.1E+09 N/m2 

Area 3.22E-03 m2 

Weight in air 1.85 kg/m 

Diameter 64 mm 

Drag coefficient 1.2 

Added mass coefficient 1.0 

  

Properties of Bottom chain Value 

E-modulus 1.1E+11 N/m2 

Area 8.04E-04 m2 

Weight in air 20.4 kg/m 

Diameter 32 mm 

Drag coefficient 1.2 

Added mass coefficient 1.0 

 

Start with adding properties for Frame rope by right click Component 10 > 

Edit. Type the information from table in the Edit component window. When 

defining the weight of rope in water, select the check box next to Weight in 
water. A warning dialogue appears, stating that it is not recommended to change the 

calculated value. We add a slight low weight to the truss, to eliminate the buoyancy 

of the truss (i.e. negative values). 
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Select OK. 

 

4 Save 
component 
properties to 
library 

AquaEdit has the possibility to save and add properties to a library. Making 

modelling of components with identical properties more efficient. In the components 

window, right click Frame rope (64mm) > Library. 

 

 
 

The Library for TRUSS is opened. In the library you may add, edit or apply 

properties to existing or new TRUSS elements.  

 

 

 

 

 

 



 

aquastructures 
 

Page 56 of 133 

 

You should save the properties of Frame rope (64mm) to the library. First, you need 

to navigate to where you want to save the properties; select the folder truss and 

then click ROPE.  

 

 
 

Select the check box for Include name and select Export. AquaEdit suggest a 

name according to the component name. Select OK. 

 

 
 

The Edit truss window opens. If you must conduct any modification before saving to 

library, this can be done here. Select OK.  

 

 
 

In the Save change into library window, select OK. Then, exit the Library for 

truss window. 

 

 

 



 

aquastructures 
 

Page 57 of 133 

 

5 Add properties 
from Library 

For the properties of Bridle rope you should add them from the properties library of 

TRUSS elements. In the components window, right click Component 11 > 

Library. In the folder tree to the left, navigate to truss > ROPE, select 

Superdan_3-str. From the table in step number 3, we see that the diameter of the 

rope should be 48 mm. In the middle column, select Superdan_48mm and then 

Apply. 

 

 
 

Open the Edit truss window by double click on Component 11. Change the 

name of the component to Bridle rope (48mm). Compare the values in the Edit truss 

window with the values provided in the table from step number 3. If no differences 

are observed, select OK. 
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6 Properties of 
Mooring rope 

The Mooring rope should have identical properties as the Fram rope, i.e. 64 mm. In 

the Components window, right click Component 12 > Library. Navigate to 

where you saved the properties from Frame rope (64mm). Select saved properties by 

left click Frame rope (64mm) in the middle column, select Apply. 

 

 
 

You may change the name of the component by double click Component 12 in 

the components window and assign the name Mooring rope (64mm). 
 

 

7 Properties of 
Bottom chain 

Enter the Edit TRUSS window for the last component by double click 

Component 13.  

 

Trusses in AquaEdit assumes a single circular cross section, but chains are assembled 

by loops of steel rings. To account for this, both cross sectional area and diameter can 

be defined with twice the provided diameter from the table. In the Edit TRUSS 

window type values according to the figure below. 

 

 
 

The font of all components should now have changed from italic to straight, 

indicating that required properties are added. If not, you should open the Edit TRUSS 

window for the components and check your parameters. 
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8 Draw Frame 
rope 

The frame should be modelled as 60m x 60m at a depth of 7m. When drawing 

structures, the current component must first be activated. 

 

Activate the component Frame rope (64mm) by left click in the Components 

window. There are several methods for modelling the frame, one is described below. 

 

From the Toolbar menu, select the intent Draw rectangle . In the lower most 

toolbar, to the left, type the coordinates of the first node x=-30 Y=-30 Z=-7 

, press ENTER on your keyboard. Select the checkbox to 

the right for activation of relative coordinates. Type x=60 Y=0 Z=0 

, press ENTER. For the last node, type x=0 Y=60 Z=0 

. The preview of the drawn rectangle should resemble 

the figure below. 

 

 
 

Press ENTER on your keyboard. 

 

 

9 Draw Bridle 
rope 

The bridle should be of type 3-part. Meaning that the floating collar is restrained by 

pairs of 3 bridle ropes in each frame corner. Activate the bridle component by left 
click Bridle rope (48mm) in the Components window. To ease modelling, select 

Top view  and then activate the Snap function .  
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Select Draw line  and click on the lower left corner of the frame, then select 

the node on the Outer floating pipe that result in a line segment 45 degrees (in XY-

plane) with respect to the horizontal frame. Press Esc once to escape the continuous 

line modelling. Do not mind if the color of the elements does not resemble our 

figures, it has no significance for the properties of your model.  

 

 
 

Tip! Select the correct node on the Outer floating pipe by first move your mouse 

pointer to the node diagonal in the frame. The correct node is the intersection point 

between the preview line and the Outer floating pipe. 

 

 
 

The two other bridle ropes should be attached to the Outer floating pipe on each side 

of the first. Select the node on Outer floating pipe counting three brackets clockwise, 

and then select the corner node of the frame. 
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Repeat this for the last bridle rope. 
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10 Duplicate 
segments 

For repeating and time-consuming modelling steps, the Duplicate function is useful. 

You should now duplicate the bridle elements to the remaining frame corners. 

 

Select the bridle elements either by left click + CRTL and select the three 

elements. Or in the Components window left click Bridle rope (48mm) > 

Operations > Select. 

 

 
 

 

In the Toolbar select Duplicate . In the Tool properties window, 3 pairs of 

segments should be duplicated, and rotated 270 degrees about the global z-axis about 

origin (Pivot). 

 

 
 

Select Duplicate. With these selections, you model should resemble the figure 

below. 
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11 Draw Mooring 
rope and Bottom 
chain 

The mooring ropes should have a length of 220m at -100m depth. Activate Mooring 
rope (64mm) from the Components window and select Draw line. Start the line 

from the lower left node in the frame, activate relative coordinates in the checkbox 

and type X=-200 Y=0 Z=-93, this should result in a mooring rope approximate to 

length of 220m. 

 

 
 

To model the Bottom chain go to the Components window and select Bottom chain 
(32mm). If you still have the Draw line intent activated, select End node as 

indicated in the figure above. If the intent is deactivated, reselect Draw line by 

pressing  from the Toolbar menu. The chain should be 27.5m long, this is done 

by typing X=-27.5 Y=0 Z=0 in the lower toolbar. Make sure relative coordinates is 

activated. 
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Repeat the procedure for modelling of mooring rope and bottom chain for additional 

three times, with the structure as shown in the figure below. 
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12 Buoys You should now model buoys in each corner of the frame rope. For simplicity 

reasons, we model them in the corner nodes connection the frame and not in the 

water line.  

 

Select the lower left node of the frame, right click > Nodes > Spring > 

Create new. 

 

 
 

This will open the Edit spring window. Dedicate a suitable name, e.g. Buoy (frame). 
There are several types of springs available in AquaEdit, you should choose BUOY. 

 

 
 

In real life, the buoy will intersect the water line. The intersection area will provide 

the buoy with a waterplane stiffness. You are going to add a water plane stiffness in 

z-direction. This is the parameter significant for position of the frame. In the Stiffness 

section type Z=1E+04 N/m, this will correspond to a buoy with a waterplane area of 

approximate 1m2. 
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Select OK. The node with the buoy should now have changed color to red. 

 

To add buoys to the remaining corner nodes, you may apply multi-selection. Multi-

selection is activated by hold CTRL + left click on nodes. Select the remaining 

three corner nodes right click > Nodes > Spring > Add to… > Buoy 
(frame). 

 

 
Buoys should now have been added to the three remaining nodes. 

 

 

 

 

13 Boundary 
conditions 

At the end of the chain, a mooring bolt or anchor is attached. To resemble this, the 

end nodes are restrained in all 6 Degrees of freedom. Multi-selection is activated by 

hold CTRL + left click on nodes. 
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In the Nodes properties window select all the checkboxes in the row DOF. 

 

 
 

14 Discretization The mooring components should be discretized with the number of elements 

according to the table below. 

 

Component name Number of elements 

Frame rope (64mm) 4 

Bridle rope (48mm) 4 

Bottom chain (32mm) 4 

 

Select the intent Split line  and discretize the component by left click on the 

components in the 3D view. After discretization, the model should resemble the 

figure below. 

 

 
 

You should wait with discretization of Mooring rope (64mm) until terrain has been 

loaded and the chain nodes are snapped to terrain. 

 



 

aquastructures 
 

Page 68 of 133 

 

15 Duplicate 
cage 

The model is to be extended to a 2 x 2 cage facility with identical net, floating collar, 

suspension, and bridle. Instead of model the same floating collar, net suspension, and 

bridles form scratch, you can apply the duplicate function. First, you need to select 

the elements for duplication.  

 

You can select the whole cage by left click in lower right corner of the 3D view, hold 

and drag the mouse pointer to the upper left corner. 

 

 
 

At the moment you do not want to duplicate the mooring ropes. De-select these 

components by hold CTRL and left click on the mooring elements in the 3D 

viewer.  

 

 
 

In the Toolbar menu, select Duplicate. You should duplicate the cage by 1 in the X-

direction next to the existing. In the Properties window for Duplicate choose 

Segments=1 and Vector=60 (this corresponds to the size of the frame). 
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Select Duplicate. 

 

Then select the two cages, except from the mooring ropes, and duplicate them with 1 

segment in Y-direction. 

 

 
 

Select Duplicate. You should now have 2 x 2 cage system. 
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16 Duplicate 
Mooring rope 
and Bottom 
chain 

Select the mooring rope and associated chain on the left side of the cages. Duplicate 

these elements by 1 segment and 60m in Y-direction. 

 
 

In the Tool properties window, select Duplicate. 

 

Repeat this for the mooring rope and chain in the lower right corner. Duplicate these 

elements by 1 segment and 60 m in X-direction. 

 

 
 

In the Tool properties window, select Duplicate. 
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17 Mirror 
Mooring rope 
and Bottom 
chain 

Elements can also be mirrored. Select the three lower most mooring ropes and 

associated chain in the 3D view. From Toolbar menu, select the intent Mirror . 

You must now draw an axis upon the elements is to be mirrored about. Select the 

nodes as indicated in figure below.  

 

 
 

Select Mirror in the Properties window. 

 

 The three sets of mooring ropes and chain should also be mirrored. In the 3D view, 

select the three left most mooring ropes and associated chain. From the Toolbar 

menu, select Mirror. Select nodes as indicated below so that a mirror axis in Y-

direction is generated.  

 

 
 

Select Mirror in the Properties window. 
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18 Import terrain The Import terrain options in found in Commands > Import terrain. A terrain 

model is prepared in terms of a .obj-file. This is a geometry definition file presenting 

vertexes and faces of polygons.  

 

For AquaEdit to be able to position the terrain correctly, datum and position data is 

needed. In this case study, the .obj-file is prepared so you do not need to consider 

these parameters.  

 

In Additional datasets, select Add and navigate to 

Documents\AquaSim\Demoes\CaseStudy03 and select the .obj-file. Select Open. 

 

 
 

In the Import terrain data window, select OK. The terrain is added to the Components 

window with the component type TERRAIN. 
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19 Save the 
model 

Remember to save your model regularly, so that data is not lost. 

 

20 Snap node to 
terrain 

The bottom chain has been modelled at a depth of -100m, you should now snap the 

chain nodes to the terrain. Select all the nodes associated with the Bottom chain 
(32mm) in the 3D view.  

 

For multi-selection of nodes, left click on one node and hold CTRL, then drag 

your mouse pointer from right to left so the selection square cover the chain. 

 

 
 

Right click in the 3D view > Nodes > Snap node to terrain. 
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The nodes connected with Bottom chain (32mm) is now moved from modelled 

position down to the terrain. 

 

21 Discretization 
of Mooring rope  

Split the elements associated with Mooring rope (64mm) in 10 elements. Select the 

intent Split line  with Number of segments= 10. 

 

 
 

 

22 Verify model Verify the input parameters in the model Commands > Verify model. AquaEdit 

gives a warning for short elements.  

 

 
 

Tolerances for errors and warnings can be edited in File > Settings > Errors 
and warnings. Accept the warning, select Close. 
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4.5 Calculations static analysis 
 

23 Enter 
environmental 
window 

Enter the Environmental window by selecting Export . You should run a 

static analysis and control key parameters for equilibrium in the model.  

 

Select the tab Normal. Prepare the static analysis by making selections as described 

in the figure below. We have highlighted the selection for Water volume correction to 

be With slamming. This is due the components constituting the floating collar is 

dedicated the load formulation Morison submerged. AquaSim will identify if these 

elements are above or below the water surface and adjust the hydrodynamic 

properties for each analysis step. More detailed information about export parameters 

is found in CaseStudy01 or by reading the AquaEdit User Manual. 

 

 
 

The area outlined in orange provides selection of solver versions. Your solver version 

may deviate from the figure above. You should choose the latest version from the 

dropdown menu. 

 

Select Export. Navigate to a folder where you want to save the analysis. In this case 

study, we have chosen Documents\AquaSim\Analyses\CaseStudy03 and created a 

folder Static. 

 

Type an appropriate name of the analysis file, we have chosen static. 

 

   Select Export. 
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24 Run static 
analysis 

The Analyse window opens. To start the analysis select Start or Start all. 

 

 
 

If you select Show message, you will be provided with key information about the 

analysis, which solver is run, statistics of input-parameters and status for each 

number of analysis step. It reports whether the analyzed step has converged or not, 

useful when assessing how the analysis evolves.  

 

 
 

The analysis is successfully completed when the square in the upper left corner of the 

Analyse window gets green with the status finished. 
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4.6 Postprocessing static analysis 
 

25 System files In your file explorer, navigate to where you saved the analysis. In our case, 

Documents\AquaSim\Analyses\CaseStudy03\Static. Upon start and finish of 

analysis, several system files are generated. An introduction to these is provided here. 

 

 
 

File name File Description 

static.bat Batch file Script file for run of commands. Double 

click to start the analysis. This is consistent 

with starting analysis in AquaEdit from 

Export. 

static.xml XML file This file holds the graphic information and 

other key data. 

static01.AVS Result file Result file generated by the solver. Updated 

for each completed analysis step. Can be 

opened in AquaView and AquaTool during 

and after completion of analysis. 

static01.avz Result file Result file generated by the solver after 

completion of analysis. This is a compressed 

version of the .AVS-file. 

static01.txt Input file Holds information about the model and 

analysis parameters. Generated from 

AquaEdit upon start of analysis.  

static01.xml XML file Holds graphic information and other key 

data for activated components from 

AquaEdit.  

static01conv.txt Result convergence file Provides information about the analysis 

status. Consistent with the information 

provided in the Show message form the 

Analyse window. 

static01-elements.txt Result ID file If individual elements are given custom 

names in AquaEdit, these are listed here. 

static01key.txt Result file key data Contains a set of key data of the analysis 

model. This file is useful for self-checking 

of input parameters. Also holds information 

about license and the user. 

static01-nodes.txt Result ID file If individual nodes are given custom names 

in AquaEdit, these are listed here. 

static01PFAT.AVS Result file Result file generated by the solver upon 

completion of analysis. Holds information 

about key model data and max result values 

from the time series analysis. 

static01PFAT.avz Result file Result file generated by the solver upon 

completion of analysis.   
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static01val.txt Result file validation data This file holds key data for the analysis. 

Useful for self-validation of input 

parameters. 

terrain23[..]66.obj Object file Contain information about terrain geometry. 

 

 

26 Buoyancy of 
floating collar 

The key.txt file is useful for self-check of key parameters from your model. Open the 

static01key.txt-file in a simple text editor reader e.g., Notepad or Notepad ++.  

 

Navigate to the section saying Weight in total for each element group. These 

parameters are based on the input values from AquaEdit (i.e., before static 

equilibrium is calculated). 

 

 
 

Components are listed according to the numbering from the Components window in 

AquaEdit. Component 1 correspond to Inner floating pipe (Ø400 SDR 16.7), 
component 2 correspond to Outer floating pipe (Ø400 SDR 16.7), and so on. Copy 

the parameters as indicated in orange and paste them in a calculation program after 

your preferences. We have chosen MS Excel. 

 

Summarize the buoyancy for the components constituting the floating collar. And 

summarize the weight below water line for the mooring components. 

 

 
 

For elements of type Morison submerged, the buoyancy is calculated based on the 

volume of the whole cross section (this is adjusted when static equilibrium is 

calculated). Note the total buoyancy of the floating collar and the total weight of the 

mooring components. Keep these figures for future reference when conducting 

CaseStudy04.  
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27 Check of key 
parameters 

Other key parameters found in the static01key.txt file is information about weight 

and mass. 

 

 
 

Navigate to the section saying Total, all elements. Two parameters indicating the 

state of your model is highlighted in the figure above: 

- Diffrac = Weight / Buoyancy of all elements, provides information about 

the relation between weight and buoyancy of components in your model. 

If this balance is perfect, Diffrac should equal 1.0. If this number is far 

from 1.0 this can indicate e.g., inadequate definition of volume of 

components compared to the weight of it. 

- Weight elements (N) / Mass elements (kg), provides information about 

the relation between weight and mass of components in your model. If 

this balance is perfect, this parameter should equal 9.81. You should not 

accept significant deviances from 9.81, which indicates e.g., inadequate 

definition of Weight in water. If Weight in water is overridden, as we did 

for component Frame rope (64mm) in step number 3, deviance from 

9.81 must be expected. 

Further self-checking can involve controlling Downwards force of node loads [N], 
which is reported to be a total of 16000.0N. This can be validated through 

controlling the input defined in AquaEdit. Go back to your AquaEdit model, and to 

the Decorators window. Here you find a Pointload which is located at the bottom of 

each net pen. Double click Bottom weight (net) in the Decorators window. A 

force of -4000N is defined, this will result in a total of 4000 times 4 net pens = 

16000N in total downwards force in your model. This matches the value in the 

static01key.txt-file. 

 

Exit the static01key.txt-file. 
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28 Open results 
in AquaView 

From the analysis folder Static, open the analysis in AquaView by double click 

on static01.avz. This is equivalent to selecting Open from the Analyse window. 

 
 

Press Play  from the playback menu and observe the response of your model. 

Zoom in to structural details and see how it displaces. If your analysis, against 

conjecture, should have failed to complete successfully, or an unexpectedness have 

occurred, you can open the equivalent result file from 

Documents\AquaSim\Demoes\CaseStudy03\Static.  

 

29 Pretension of 
mooring 
components 

As a result of the mooring component’s weight in water, they will achieve a 

pretension. The pretension is found by plotting the axial forces. In the Toolbar menu, 

select Result > Local section forces > Axial force [N]. You should find 

the maximum pretension for the mooring components; these can be found by pressing 

j on your keyboard. 

 

 
 

The first column in the Max values for- window list the component names according 

to the definition you made in AquaEdit. The second column is the component 

numbering, or index. The third column is the maximum value for the respective 
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component group, and the last column indicate which analysis step this max value 

occurred. 

 

Copy the rows for component number 10 to 12 and paste it in the same sheet you 

established for the key-data. 

 

 
 

Keep these figures for future reference when conducting CaseStudy04. 

 

 Static considerations are now finished. Exit AquaView and the Analyse window from 

AquaEdit. 
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4.7 Calculation dynamic analysis 
 

30 Enter 
Environmental 
window 

Go back to your model in AquaEdit. You should investigate the response and forces 

in mooring components for two combinations of waves and current. Enter the 

Environmental window by selecting Export  from the Toolbar menu. Select 

the tab Directional . In Directional, the environmental loads are 

based on defining directions from where AquaSim decomposes the loads into vectors. 

 

 

31 Load 
conditions and 
Export 
parameters 

Each row in the Directional window represents a combination of environmental 

loads, equivalent to the Normal tab. 

 
 

The input values for the load conditions (LC) are described in the table below. 

 
Nr SysH[deg

] 

Hs[m] T[s] WaveH[d

eg] 

Vc[m/s] CurrDir 

[deg] 

U10[m/s] 

Row 

numbe

r of the 

LC 

System 

heading, 

orientatio

n of the 

model 

from 

compass 

north to 

the global 

x-axis. 

Clockwis

e, in 

degrees. 

Significan

t wave 

height. 

The 

average 

wave 

height 

(from 

trough to 

crest) if 

the 

highest 

one-third 

of the 

waves. In 

meters. 

Period of 

the 

associated 

wave 

height. In 

seconds. 

Heading 

of the 

wave. 

Waves are 

defined 

with the 

direction 

it 

originates 

from. In 

degrees. 

Current 

speed. In 

meters per 

second. 

Direction 

of current. 

Current is 

defined 

with the 

direction 

it 

propagate

s to. In 

degrees. 

Wind 

speed at 

10 meters 

altitude. 

In meters 

per 

second. 

1 0 0.5 2.5 0 0.5 / 0.3 180 / 180 0 

2 0 1 3.0 45 0.3 / 0.2 225 / 225 0 

 

The slashes for Vc and CurrDir indicates a non-uniform current profile in the water 

column. The system heading provides a global orientation of the environmental 

loads. This facilitates modelling because you do not have to consider the orientation 

of the aquaculture facility when you are building the system. Note that the definition 

of wave direction is from, meaning that the input direction is from where waves 

originate. Current is opposite, where the definition of current direction is to, meaning 

that the input direction is to where the current propagates. 
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In the Environmental window, click on row number 1 and select Edit. In the Edit 

load window, type the values for LC 1. To add varying current, go to the Varying 
current tab, select the checkbox for Active and Add two rows.  

 

 
 

Select Save. 

 

Add a new row for load condition 2 and fill in the environmental values from the 

table, following the same procedure as described above. When finished, select Save.  

 

 
 

Make sure load conditions are activated by selecting the checkboxes in upper left 

corner of the window. Dynamic analysis with two regular waves should be 

conducted; Num total steps for waves = 24 and Num steps for one 
wave = 12. This corresponds to a wave profile defined with 12 points and 24/12= 2 

waves. The remaining settings in your Environmental window should be similar to 

the figure above. 
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 Select Export. Navigate to an appropriate place to save the analysis, we have chosen 

Documents\AquaSim\Analyses\CaseStudy03\Dynamic. Type an analysis name 

e.g., dynamic. 

 

 
 

Select Export. In the Analyse window, select Start all. 

 

 
 

Dynamic analysis of the aquaculture facility has now started. Depending on your 

computer, this analysis should be finished within approximate 10-15 minutes. Follow 

status and development of the analysis by selecting Show message. 

 

32 Create max 
out file 

The maximum resulting forces from a set of analyzed load conditions are for the most 

of it applied when designing and dimensioning mooring systems. AquaSim finds the 

maximum values and store them in a max-out-file. This can be generated by selecting 

Create max out in the Analyse window upon completion of analysis. 

 

When both analyses are finished, select Create max out from the Analyse 

window. We leave this for later application. 
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4.8 Postprocessing dynamic analysis 
 

33 Visual 
interpretation of 
results 

Load the result file from the first load condition by selecting Open from 

dynamic01.txt in the Analyse window. 

 

 
 

Load condition 01 will be loaded in AquaView. Plot Axial force [N] and play 

the analysis by selecting Play  from the playback menu. Observe how the axial 

forces in the model evolve as waves and current passes the facility. 

 

 
 

The playback speed can be adjusted by selecting Set duration  from the 

playback menu. Unit is seconds, if you type 30 it will take 30 seconds to play from 

the first step to the last step. 

 

When observing the analysis playback, you should observe the model behaving as 

expected. That is; forces in components rise when wave passes, the net deforms due 

to current and so on. This is a type of visual validation of the analysis. If you observe 

“jumping” elements or other abnormal response, this can indicate that the analysis 

has potential for improvements. An analysis can produce erroneous results despite 

achieved convergence for all steps. “Jumping” elements or other abnormal 

fluctuations may indicate a lack of damping in the system or eigen period issues. 
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These considerations are not the scope of this case study but is highlighted as 

something to be aware of when working with dynamic problem solving. 

 

Exit AquaView. 

 

 Load the result file from the second load condition by selecting Open from 

dynamic02.txt in the Analyse window. 

 

 
 

If you have closed the Analyse window, you may load the result file from your 

analysis folder in the File Explorer. Double click on dynamic02.avz. 

 

 
 

In AquaView, you should plot the Axial force [N]. Follow the same procedure 

as for load condition 01, play the analysis and observe the response of your model. 

This is for visual validation of your model. 
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34 View terrain 
in AquaView 

The terrain may be loaded in AquaView as well. In the Toolbar menu, select Show > 

Shapes > Terrain. Depth color can also be activated by selecting Toggle depth 
color in the Shapes menu. Adjust the transparency of the water surface by dragging 

the upper blue bar to the left. 

 

 
 

Exit AquaView. 

 

35 Maximum 
resulting forces 

In this section you are to find maximum forces in the mooring components from the 

two analyzed load conditions. In your analysis folder, you will find a folder called 

maxout. Enter this folder. Here you will find files that contain maximum loads from 

both analyzes. These were generated when you selected Generate max out from 

the Analyse window in step number 32. 

 

 
 

Load dynamic_max_out.avz by double click the file. AquaView will be loaded. 

If you failed to generate the maxout-files, you can find equivalent file in 

Documents\AquaSim\Demoes\CaseStudy03\Dynamic\maxout. 
 

The maxout-file only contains maximum values from load condition 01 and 02, and 

consequently playback functionality is not available.  
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You should now find max axial force in the mooring components Frame rope 
(64mm), Bridle rope (48mm) and Mooring rope (64mm). From the Toolbar menu 

in AquaView, select Result > Local section forces > Max axial force 
[N]. 

 

 
 

Press j on your keyboard to enter the window for maximum values of each 

component group. 

 

 
 

What the different columns in this window represent is provided in step number 29 in 

this case study. In addition, we have the column File index. This column indicates 

from which load condition the max values originate.  
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Copy the abovementioned components to clipboard by selecting component number 

10 to 13 and CTRL + c. Paste the data in the same sheet you established from the 

static analysis.  

 

 
 

Keep these figures for future reference when conducting CaseStudy04.  

 

 Dynamic considerations are now finished. Exit AquaView and AquaEdit.  

 

4.9 Summary 
In this case study we have modelled an aquaculture facility in a 2 x 2 configuration of cages. Mooring 

components and terrain have been added to a prepared model. To simplify and increase effectiveness in 

modelling you have learned how to apply the properties library, duplication, and mirror of elements.  

By adding a bathymetric bottom (terrain) to the model you have seen that the bottom chain achieves a more 

realistic configuration. You have also learned about the different system files that is generated when 

performing analyses. And that these are useful when evaluating the input and condition of your model.  

Several results have been copied and transferred to a calculation sheet for future reference. In the next case 

study, you are to model the same aquaculture facility in a more simplified manner and compare results from 

this case study.  
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5 Case study 04 – Simplified aquaculture cage and mooring 
5.1 Learning objectives 
Upon completion of this case study, you will be able to: 

- Apply additional modeling intents, as draw circle, extrude elements 

- Establish routines for transferring experience and information from one analysis case to the next 

- Understand, and evaluate strategies, for choosing degree of model details 

5.2 Introduction 
You are to model the same aquaculture facility as in CaseStudy03 in a simplified manner. Through static 

analysis selected key parameters, as mooring rope tension and buoyancy of the floating collar, should be 

checked. These parameters are to be compared to corresponding figures from the previous case study, in 

order to ensure these correspond.  

By dynamic analysis, you are to find maximum axial force in selected mooring components and evaluate the 

results. 
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5.3 Main components of aquaculture facility 
The main simplifications of the aquaculture facility in this case study lies in how the floating collar is 

modelled and the discretization. Instead of modelling each floating pipe, with brackets, railing post and 

railing, the floating collar is represented with a double tube. The model and main technical specifications are 

presented in the figure and table below. 

 

 

Component number Description Technical data* 

1 Floating collar, double tube PE100, Ø400, SDR16.7, CIR120m 

2 Suspension ring for net pen PE100, Ø250, SDR11 

3 Net pen Sn15.4%, CIR120m, D15m 

4 Frame rope 64mm, L60m, W60m 

5 Bridle rope 48mm 

6 Mooring rope 64mm, L220m 

7 Bottom chain 32mm, L27.5m 

8 Buoy L1.0m, W1.0m 

* Abbreviations: PE=polyethylene, Ø=pipe diameter, SDR=pipe diameter/wall thickness, 

CIR=circumference, Sn=solidity, D=depth, L=length, W=width. 
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5.4 Preprocessing 
 

1 Load AquaEdit The model should be built from scratch. Load AquaEdit. 

 

 
 

2 Generate 
component 
groups 

From the table in section 5.3 you see the model consist of 7 components, in addition 

to buoys. Buoys are considered as a node decorator in AquaEdit, and not as a 

component.  

 

From the Components window, generate six additional new component groups by 

selecting New component. 

 

 
 

We need to decide for the component types. The type depends on the cross-sectional 

characteristics of the various components. You should evaluate if the component is 

able to withstand only axial/ compressive forces, is it able to withstand bending and 

torsion moments, is it a fabric type?  
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Below you find evaluation of the different components and the component types. 

 
Component number Evaluation Component type 

1 Floating collar (Ø400 

SDR16.7) 

A floating collar consist of polyethylene 

pipes and brackets with massive thickness. 

These cross sections can withstand 

axial/compressive-, bending-, and torsional 

forces. The component type should then be 

BEAM. 

BEAM 

2 Suspension ring (Ø250 

SDR11) 

The suspension ring is made of polyethylene 

pipe with a massive thickness. It is able to 

withstand axial/compressive-, bending-, and 

torsional force. The component type should 

then be BEAM. 

BEAM 

3 Net pen (Sn15.4%) The net pen is an assembly of threads, either 

sewn or tied together. The assembly will 

form a network of meshes in which water 

can flow through. The net is flexible, and as 

for ropes, only capable of withstanding 

axial- and compressive forces. The 

component type should be MEMBRANE. 

MEMBRANE 

4 Frame rope (64mm) As presented in CaseStudy03 the mooring 

components are considered flexible, only 

capable of withstanding axial- and, to some 

extent, compressive forces. The component 

type should be TRUSS. 

TRUSS 

5 Bridle rope (48mm) TRUSS 

6 Mooring rope (64mm) TRUSS 

7 Bottom chain (32mm) TRUSS 

 

In the Components window change the component types according to the table 

above. This is done by right click > Type > select appropriate component type. 
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3 Properties of 
Floating collar 

You are to assign cross sectional properties to the floating collar. The floating collar 

is modelled in a simplified manner; you are to model them as one cross section with 

similar properties as two individual pipes and brackets. In the Components window, 

double click Component 1 to enter the Edit beam window. 

 

Assign the component an appropriate name e.g., Floating collar (Ø400 SDR16.7). 
The double tube is only available for the load formulation Hydrodynamic. In the row 

Type, select Hydrodynamic from the drop-down menu. From the drop-down menu 

in Data source select Double tube. 

 

 
 

The wizard dialogue for cross sections will be loaded. The pipe diameter is 400mm, 

and the SDR is 16.7. Type Diameter (D)= 400mm, and SDR= 16.7. Distance (L) 

is the center-to-center distance between the floating pipes. By measuring the length 

of a bracket from CaseStudy03, we find this distance to be 840mm. Type Distance 
(L)= 840mm. 

 

 
 

In the Material properties section select Plastic as the material, and that the 

pipe should be filled with Air. Select OK. 
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The Information tab will be updated with a visual cross section of the double 

tube, found in the lower right corner of the window. Note that the cross section has its 

own local coordinate system with y- and z-axis. You should now control that the 

volume and weight of the double tube is consistent with the detailed model from 

CaseStudy03. Cross section properties are automatically calculated by the cross 

section wizard. Go to the Material/ section properties tab to review the 

parameters. Volume and Weight in air should be twice the corresponding 

parameters as for a one floating pipe from CaseStudy03. In the figure below we have 

compared the component Floating collar (Ø400SDR16.7) from CaseStudy04 and 

component Inner floating pipe (Ø400 SDR 16.7) from CaseStudy03. 

 

 
 

The Stress calculation tab provides parameters needed to calculate stresses in 

the component. Input values here are distances from neutral axis of your cross section 

to the edge of your cross section. 

 

Go to the Element loads tab. Here, hydrodynamic coefficients needed for the 

analysis is defined. Applying the load formulation Hydrodynamic, AquaSim 

calculates the forces based on both strip theory and Morison equation. For AquaSim 

to calculate the part for strip theory, a calculation cross section is needed. This is 

found in the Crossection-part of the Element loads tab. As you see, this part has 
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no cross section. You can either define it by typing coordinates, or you can copy the 

visual cross section you generated in the wizard.  

 

 
 

Go back to the Information tab and select Copy to hydrodynamic. Re-enter 

the Element loads tab to see an approximation of the visual cross section has 

appeared in the Crossection-part. 

 

 
 

Select OK. 
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4 Properties of 
Suspension ring 

The suspension ring should consist of a single PE-pipe with a weight of 100 kg/m in 

air. The purpose of the suspension ring is to suspend the net pen in vertical as well as 

in horizontal direction, ensuring the fish to have sufficient volume to move in. To 

achieve a reasonable weight for the suspension, the pipes are often equipped with 

chain or similar.  

 

Double click Component 2 in the Components window. Assign the name 

Suspension ring (Ø250 SDR11), and select Morison submerged as Type. The 

ring should be modelled as a tube. From Data source, select Tube. In the wizard 

dialogue for cross section, type Outer diameter(D)= 250mm and SDR= 11. 

Leave the Material properties with default values. 

 

 
 

Select OK. 

 

 
 

The weight in air is defined in the Material/ section properties tab. 

Navigate to this tab and in the row Weight in air type 100 kg/m. Select OK. 
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5 Properties of 
Net pen 

The net pen is represented by the component type MEMBRANE. With a solidity of 

15.4%. The solidity indicates the size of the mesh and the permeability. Two-

dimensional solidity is commonly calculated as: 

𝑆𝑛 =
𝑑

𝐿𝑦
+

𝑑

𝐿𝑧
 

where Sn is the solidity, d is the diameter of the thread, Ly is the mesh width and Lz is 

the mesh height. In this case study, a thread diameter of 1.73E-03m and mesh size of 

2.25E-02m in y-and z-direction will correspond to a solidity of approximate 15.4%.  

 

In the Components window, double click the component with component type 

MEMBRANE. In the Edit membrane window, you will be met with an 

Information tab. In the row Name, type a name e.g., Net pen (Sn15.4%). Type 

provides the possibility to choose between several types of membranes. For classical 

net pens, as in this case study, select Normal from the drop-down menu in the row 

Type. The row Load formulation allow for selecting different methods of how 

hydrodynamic forces should be calculated, form the drop-down menu select Normal.  

 

 
 

To define the cross sectional properties of the net pen, you should enter the 

Material properties tab. 
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E-module is the elasticity modulus of the thread, type 1.0E+09N/m2. This is 

approximately to nylon material. The Thread diameter is 1.73E-03m. The size of 

the mesh is Maskwidth Y= 2.25E-02m and Maskwidth Z= 2.25E-02m. The 

Solidity should now be close to 15.4%. 

 

Notice the option Growth coefficient. As for all types of structures at sea, the 

net pen will be exposed to growth in terms of shells and algae. To account for 

growth, AquaSim provides a multiplication factor to increase the solidity of the net. 

Growth coefficient should be equal to 1.5, and the solidity including the growth 

coefficient is found in the row Solidity incl growth. 

 

Navigate to Load properties tab. Options for mask types in the mesh is found in 

Mask type. You can choose between meshes ordered as horizontal squares, or like 

diamonds. From the drop-down menu, select Type 1, this corresponds to horizontal 

squares. From the drop-down menu in Load type, select M1: New default. This 

selection defines how drag forces is calculated with respect to how the membrane 

deforms under influence of current.  

 

 
 

The necessary properties for the net pen are now defined, select OK.  
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5 Properties of 
Mooring 
components 

The mooring components should have similar properties as in CaseStudy03. Apply 

the library to assign the mooring components properties as described in the table in 

section 5.3.  

 

Start with the frame rope, which should have the dimension 64mm. In the 

components window, right click Component 4 > Library. In the folder tree, 

navigate through truss > ROPE, in the middle column select Frame rope (64mm) 
as you generated in CaseStudy03. Then select Apply in the lower right corner of the 

window. 

 

 
 

Change the name of the component by double click Component 4 and type the 

name Frame rope (64mm). 
 

 
 

Select OK. 
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Repeat the use of library for the bridle rope (48mm) and mooring rope (64mm). 

Change the names; accordingly, Bridle rope (48mm) and Mooring rope (64mm). 
 

The last component should be the bottom chain (32mm). Right click Component 
7 > Library. In the Library for truss folder tree, select truss > CHAIN > Anchor 
chain, and in the middle column, select AnchorChain_32mm.  

 

 
 

Then select Apply in the lower right corner of the window. Double click 

Component 7 in the Components window. Apply a suitable name to the component 

e.g., Bottom chain (32mm) and de-select the checkbox for Weight in 
water. 

 

 
 

Select OK. 
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The Components window should resemble the figure below. 

 

 
 

6 Draw Floating 
collar 

Since all the cages in the aquaculture facility is identical, you can model the first cage 

and then duplicate the remaining cages. When you start modeling, it is convenient to 

draw based on the origin of the global coordinate system. From the Toolbar menu, 

activate the Snap function . 

 

The floating collar is circular and situated in the mean water line. In the Components 

window, left click Floating collar (Ø400 SDR16.7). Select the intent Draw 

circle . In the Tool properties window type Circumference= 120 and 

Segments= 32. This will generate a circle with a circumference of 120 meters and 

32 elements. Place the circle in X= 0 Y= 0 Z= 0, by SHIFT + left click in the 3D 

view. Alternatively, type the coordinates in the fields in the lower most toolbar.  

 

 
 

Press ENTER. 
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7 Draw Net pen The net pen is attached to the floating collar by shared nodes. Shared nodes are nodes 

that coincide between two components. Dimensions of the net pen is indicated in the 

figure below. 

 

 
 

In the Components window, activate Net pen (Sn15.4%). Select the intent Draw 
circle, and in the Tool properties window type Circumference= 120 and 

Segments= 16. Place the circle in X= 0 Y= 0 Z= 0. Press ENTER. 

 

 
 

The sides and bottom of the net pen should be extruded from the net pen circle. From 

the Components window, select the net pen circle by right click Net pen 
(Sn15.4%) > Operations > Select. The net pen elements in the 3D window 

should be highlighted. 

 

From the Toolbar menu, select the intent Extrude . In the Tool properties 

window, type Segments= 6 and Vector= -15 in Z-direction. From this, the net pen 

sides will be generated with 6 elements in the vertical direction 15 meters 

downwards.  
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Select Extrude. 

 

To generate the net pen bottom, select the lower most horizontal elements of the net 

pen. Apply multi-selection by CTRL + left click on elements in the 3D view. 

 

 
Tip! Orient your model in XZ-plane. Select the elements by click, hold, and drag the 

mouse pointer from left to right to select the elements. 
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Select the intent Extrude . The bottom has a depth of 5 meters and should be 

scaled in X- and Y-direction so that the tip consists of a single node.  

 

 
 

Select Extrude. 

 

 
 

8 Draw 
Suspension ring 

From the Components window, select Suspension ring (Ø250 SDR11). Select the 

intent Draw circle and type Circumference= 120 and Segments= 16. Apply the 

field for coordinates in the lower left corner of AquaEdit and type X= 0 Y= 0 Z= -15. 

 

 
 

Press ENTER. 
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9 Save the 
model 

Remember to save your model regularly, so that data is not lost. We have chosen to 

save the model at Documents\AquaSim\Analyses\ and generated the folder 

CaseStudy04. 

 

10 Draw Frame 
rope 

The frame should be modelled as 60m x 60m at depth of 7m. Activate the component 

Frame rope (64mm) from the Components window. Apply the intent Draw line, 

or Draw rectangle and follow the procedure as described in step number 8 in 

CaseStudy03. 

 

 
 

11 Draw Bridle 
rope 

The bridle should be of type 3-part. Active the component Bridle rope (48mm) from 

the Components window. Select the intent Draw line. Draw a line from the lower 

left corner of the frame to the node on the floating collar that result in a line 45 

degrees (in XY-plane) with respect to the horizontal frame. 

 

 
 

Press ESC once to escape the continuous line modelling. The two other bridle ropes 

should be attached to the floating collar counting two elements on each side of the 

middle bridle rope.  
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Duplicate the 3-part bridle rope to the three remaining corners of the frame rope. 

Select the three bridle ropes in the 3D view. Select the intent Duplicate  and 

make the selections as shown in the figure below. 

 

 
 

Select Duplicate. 
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12 Draw Mooring 
rope and Bottom 
chain 

The mooring ropes should have a length of 220m at -100m depth. The bottom chain 

should be 27.5m of length.  

 

Follow the procedure as described in step number 11 from CaseStudy03. The model 

should resemble the figure below when the mooring rope and bottom chain is 

modelled.  

 

 
 

 

13 Buoys Each corner of the frame should be assigned buoys. Select the corner nodes of the 

frame by CTRL + left click on the nodes. In the 3D view, right click > 

Nodes > Spring > Create new. 

 

 
 

In the Edit spring window, dedicate a suitable name e.g., Buoy (frame). In the row 

Type, select BUOY from the drop-down menu. Provide the buoy a vertical stiffness of 

1.0E+04 N/m.  

 



 

aquastructures 
 

Page 109 of 133 

 

 
 

Activate the buoy shape by selecting the checkbox and then select OK. The corner 

nodes of the frame will change color from black to red, indication a node decorator is 

added.  

 

14 Bottom 
weight of net 
pen 

In addition to the suspension ring, you should add a bottom weight to the tip of the 

net pen. Select the node in the bottom tip of the net pen, right click > Nodes > 

Pointload > Create new. 

 

 
 

Dedicate the node a vertical load in negative Z-direction of -4000N, similar as to the 

figure below. 
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Activate the shape by selecting the checkbox and then select OK.  

 

15 Boundary 
conditions 

At the end node of the chain, a mooring bolt or anchor is attached. To resemble this, 

the end nodes are restrained in all Degrees of freedom. Select all four end nodes of 

the bottom chain and select all the checkboxes in the row DOF of the Nodes window. 

 

 
 

 

16 Discretization The mooring components should be discretized with the number of elements 

according to the table below. 

 

Component name Number of elements 

Frame rope (64mm) 4 

Bridle rope (48mm) 4 

Bottom chain (32mm) 4 

 

Select the intent Split line  and discretize the component by left click on the 

components in the 3D view. After discretization, the model should resemble the 

figure below. 
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You should wait with discretization of Mooring rope (64mm) until terrain has been 

loaded and the chain nodes are snapped to terrain. 

 

17 Duplicate 
cages 

The model is to be extended to a 2 x 2 cage facility with identical components. You 

are to duplicate the cage in both X- and Y-direction. 

 

First, you need to select the elements for duplication in the 3D view. Deselect the 

mooring ropes if necessary. 

 

 
 

From the Toolbar menu, select Duplicate and make selections as described in the 

figure below. 

 

 
 



 

aquastructures 
 

Page 112 of 133 

 

Select Duplicate. 

 

Then select the two cages, except from the mooring ropes. 

 

 
 

From the Toolbar menu, select Duplicate and make selections as described in the 

figure below. 

 

 
 

Select Duplicate. 
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18 Duplicate 
Mooring rope 
and Bottom 
chain 

The remaining mooring rope and bottom chain should be added to the facility. From 

the 3D view, select the mooring rope and associated chain on the left side of the 

cages. Duplicate these elements by 1 segment and 60m in Y-direction.  

 

 
 

In the Tool properties window, select Duplicate. 

 

Repeat this for the mooring rope and chain in the lower right corner. Duplicate these 

elements by 1 segment and 60m in X-direction. 

 

 
 

In the Tool properties window, select Duplicate. 

 

19 Mirror 
Mooring rope 
and Bottom 
chain 

You should model the remaining mooring ropes and bottom chain by applying the 

mirror intent. 

 

From the 3D view, select the three lower most pairs of mooring rope and chain and 

select Mirror . Choose the mirror axis by node selection in the 3D view. 
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In the Tool properties window select Mirror. 

 

Select the three left most pairs of mooring rope and chain and select Mirror. Choose 

the mirror axis by node selection in the 3D view. 

 

 
 

In the Tool properties window select Mirror. 

20 Import 
terrain 

You should import the same terrain as applied in CaseStudy03. Follow the same 

procedure to import terrain as described in step number 18 in CaseStudy03. The 

terrain .obj-file is found in Documents\AquaSim\Demoes\Casestudy03. 
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21 Snap nodes to 
terrain 

The bottom chain has been modelled at a depth of -100m, you should snap the chain 

nodes to the terrain. From the 3D view, select all the nodes associated with the 

component Bottom chain (32mm).  
 

For multi-selection of nodes, left click on one node and hold CTRL, then select 

the remaining nodes. Right click > Nodes > Snap node to terrain. 

 

 
 

The nodes connected with Bottom chain (32mm) is now moved from modelled 

position down to the terrain.  

 

22 Discretization 
of Mooring rope 

Split the elements associated with Mooring rope (64mm) in 10 elements. Select the 

intent Split line, and in the Tool properties window type Number of 
segments= 10. 
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23 Verify model Verify the model from Commands > Verify model.  

 

 
 

Your model is now successfully completed. 
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5.5 Calculations static analysis 
 

24 Enter 
Environmental 
window 

From the Toolbar menu in AquaEdit, select Export . You should run a static 

analysis and control key parameters for equilibrium in the model.  

 

Select the tab Normal. Prepare the static analysis by making selections as described 

in the figure below. We have highlighted the selection for Water volume correction to 

be Normal. This is due to the type Hydrodynamic, for the floating collar, is not 

supported with the adjustments provided for the With slamming-option.  

 

 
 

Select Export. Navigate to a folder where you want to save the analysis. We have 

chosen Documents\AquaSim\Analyses\CaseStudy03\Static. Type an analysis 

name e.g., static. Select Export from the folder navigation window. 

 

25 Run static 
analysis 

The Analyse window opens. Start the analysis by selecting Start or Start all. 

 

 
 

The analysis is successfully completed when the square in the upper left corner of the 

Analyse window gets green with the status finished.  
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5.6 Postprocessing static analysis 
 

26 Check of 
buoyancy 

You should now check and compare key parameters from the static analysis. Go to 

your analysis folder Documents\AquaSim\Analyses\CaseStudy04\Static and load 

the file static01key.txt. 
 

Navigate to the section Weight in total for each element group and copy the weight 

statistics to the calculation sheet as established in CaseStudy03. 

 

 
 

The In water buoyancy of the floating collar and In water weight of mooring 

components should be compared to the figures achieved in CaseStudy03. 

 

The resulting buoyancy of the floating collar in CaseStudy04 is approximate half of 

what achieved in CaseStudy03. This is due to how the volume is calculated. For 

elements of type Morison submerged (CaseStudy03) volume of the whole floating 

pipe is included, upon static equilibrium this is adjusted. For elements of type 

Hydrodynamic (CaseStudy04) the submerged volume as defined in the input is 

included. Remember, for type Hydrodynamic AquaSim calculates hydrostatic 

properties based on the values defined in AquaEdit. 

 

 
 

The in water weight of mooring components compare well between CaseStudy04 and 

CaseStudy03. This will affect the pretension of the mooring components. 
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27 Check of key 
parameters 

In your static01key.txt-file, navigate down to the section saying Total, all elements. 

You are to compare the differences in how Diffrac and Weight elements (N) / Mass 
elements (kg) have changed between CaseStudy04 and CaseStudy03.  

 

 
 

The Diffrac has increased in CaseStudy04 compared to CaseStudy03. This is due the 

buoyancy in the simplified model has reduced, as described in step number 26. 

 

The Weight elements (N) / Mass elements (kg) is more or less the same. This is 

because the weight and mass of the two models compare well. 

 

Exit the static01key.txt-file. 
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28 Open results 
in AquaView 

Load static01.avz in AquaView. Press Play  from the playback menu and observe 

the response of your model.  

 

 
 

Zoom in on structural details and see how the model displaces.  

 

29 Pretension of 
mooring 
components 

As a result of the mooring component’s weight in water, they will achieve a 

pretension. The pretension is found by plotting axial forces. From the Toolbar menu, 

select Result > Local section forces > Axial force [N].  
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Copy the rows for component number 4 to 6 and paste it in the calculation sheet. 

Compare the figures between CaseStudy04 and CaseStudy03. 

 

 
 

AS seen, the figures compare well between the two case studies.  

 

 Static considerations are now finished. Exit AquaView and the Analyse window from 

AquaEdit. 

 

  



 

aquastructures 
 

Page 122 of 133 

 

5.7 Calculation dynamic analysis 
 

30 Load 
conditions and 
Export 
parameters 

Go back to your model in AquaEdit. You should investigate the response and forces 

in mooring components for the same two load conditions as in CaseStudy03.  

 

Enter the Environmental window be selecting Export . Select the tab 

Directional . Input the same load conditions by follow the steps as 

described in step number 31 from chapter 4.7. Apply time series parameters and 

Export options as described in the figure below. The Water volume correction should 

be Normal. 

 

 
 

Select Export. Navigate to an appropriate place to save the analysis, we have chosen 

Documents\AquaSim\Analyses\CaseStudy04 and created the folder Dynamic. The 

analysis is called dynamic. 

 

 
 

Select Export.  
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In the Analyse window, select Start all.  

 

 
 

The dynamic analysis has started. Depending on your computer, this analysis should 

be finished within approximate 1-2 minutes. Follow the status and development of 

the analysis by selecting  

 

31 Create max 
out file 

Upon completion of the analysis, select Create max out from the Analyse 

window.  
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5.8 Postprocessing dynamic analysis 
 

32 Open max out 
results 

In the Analyse window, select Open folder. Enter the folder maxout and open 

dynamic_max_out.avz by double click. 

 

From the Toolbar menu in AquaView, select Result > Local section forces > 

Max axial force [N]. 

 

 
 

If problems have occurred in your model or analysis, you can retrieve similar results 

from folder Documents\AquaSim\Demoes\CaseStudy04\Dynamic. 

 

Press j on your keyboard to enter the window for maximum values of each 

component group.  

 

 
 

Copy the rows for component group number 4 to 7 and paste it in the calculation 

sheet you have established.  
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33 Evaluation of 
results 

You should compare the maximum achieved axial forces from the two load 

conditions with CaseStudy03. In the figure below, the axial forces in the mooring 

components are reported for CaseStudy03 and CaseStudy04.  

 

 
 

By comparing, we see that the forces generally compare well, but some differences 

are observed. The reason for this is complex, and come from, among other things, 

differences in discretization of the model that will lead to a different response when 

exposed to dynamic loads. 

 

An aquaculture facility is mainly exposed to drag forces, this is due to the net pen 

having a large area exposed to current and waves. These forces will propagate further 

into the mooring components. In this case study, the net pen was modelled with fewer 

elements compared to CaseStudy03. Leading to a slightly different deformation of 

the net pen.  

 

Dynamic considerations are finished. Exit AquaView, the Analyse window and close 

AquaEdit. 
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5.9 Summary 
This case study was intended to provide understanding of the consequences of the level of details in your 

model. You have modelled an aquaculture facility identical to the one established in CaseStudy03, but in a 

more simplified manner.  

To ensure that hydrostatic properties are consistent, key parameters of both models are compared after 

completed static analysis. By comparing axial forces achieved in CaseStudy04 with CaseStudy03, we see 

that they compare well. At the same time, you have reduced the complexity in the model and reduced 

computational time significantly. From 10-15 minutes in CaseStudy03 to 1-2 minutes in CaseStudy04 for 

dynamic analysis. 

From this we can conclude that the level of detail of your model must be assessed based on the purpose of 

your analysis.  
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6 CaseStudy 05 – Simplified aquaculture cage and lice skirt 
6.1 Learning objectives 
Upon completion of this case study, you will be able to: 

- Apply properties of an impermeable tarpaulin (lice skirt) 

- Execute non-linear dynamic analysis 

- Assess the impact lice skirt have on loads in mooring components 

6.2 Introduction 
In this case study you are to complete a model of an aquaculture facility equipped with impermeable 

tarpaulins. Impermeable tarpaulins are commonly applied to prevent and reduce lice infestation and are 

referred to as lice skirts. The name originates from how it is installed at the facility – it is attached to the 

floating collar and extends down along the outside of the net pen, as it was a skirt. 

You are to conduct a dynamic analysis, applying the same environmental conditions as in CaseStudy04 and 

assess how forces in mooring component forces are affected by the presence of lice skirts by comparison.  
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6.3 Preprocessing 
 

1 Open model Open the prepared model CaseStudy05.amodel from 

Documents\AquaSim\Demoes\CaseStudy05. 

 

 
 

This model is identical to the one established in CaseStudy04, with floating collar, 

net pen, mooring components and terrain. The difference is that 4 lice skirts are 

included. The skirts extend 7.5m below the water surface. 

 

2 Properties of 
Lice skirt 

Lice skirts are impermeable and flexible tarpaulins, in oppose to net pens where 

water is allowed to flow through. You should change the load formulation of the 

associated lice skirts, so it resembles an impermeable tarpaulin. 

 

In the Components window, double click Lice skirt 1. Select the drop-down 

menu for Load formulation and select Impermeable net. 
 

 
 

Repeat this procedure for Lice skirt 2, Lice skirt 3 and Lice skirt 4.  



 

aquastructures 
 

Page 129 of 133 

 

3 Verify model Verify the input of your model by selecting Commands > Verify model.  

 

 
 

4 Save model Remember to save the model. Select File > Save as…. Navigate to a folder where 

you want to save the model. We have chosen 

Documents\AquaSim\Analyses\CaseStudy05. Give the model a name e.g., 

Facility_lice_skirt.amodel. 
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6.4 Calculations dynamic analysis 
 

5 Load 
conditions and 
export 
parameters 

From the Toolbar menu in AquaEdit, select Export. Necessary analysis parameters 

are prepared, check that these are consistent with the figure below. 

 

 
 

Select Export and choose an appropriate place to save the analysis, we have chosen 

Documents\AquaSim\Analyses\CaseStudy05 and created the folder Dynamic. 

Give the analysis a name and select Export. 

 

In the Analyse window, select Start all. 

 

 
 

Depending on your computer, this analysis should be finished within approximate 3 

minutes. 
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6 Create max 
out file 

Upon completion of the analysis, select Create max out from the Analyse 

window. 

 

 
 

The analysis is now finished.  
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6.5 Postprocessing dynamic analysis 
 

7 Open max out 
results 

From the Analyse window, select Open folder. Navigate to the folder maxout and 

load the file dynamic_max_out.avz by double click.  

 

From the Toolbar menu in AquaView, select Result > Local section forces > 

Max axial force [N]. 

 

 
 

Press j on your keyboard to enter the window for maximum values of each 

component group. 

 

 
 

Copy the rows for component group number 8-11 and paste it in the calculation sheet 

you have established.  
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8 Evaluation of 
results 

You should compare the maximum axial forces from the two load conditions with 

CaseStudy04. In the figure below, the axial forces in the mooring components are 

reported for CaseStudy04 and CaseStudy05. 

 

 
 

By comparing, we see that the forces in Mooring rope (64mm) and Bottom chain 
(32mm) have increased in CaseStudy05. This is due to the lice skirts, where the fluid 

particles are forced to flow around the impermeable net, causing an increase of drag 

forces. The forces are transferred to the mooring ropes and bottom chain.  

 

The axial force in the frame rope, is on the other hand, reduced. This can be 

explained by the added mass that is associated with the lice skirt. On the inside of the 

fish cage water mass is captured. It will take time to move all this water mass, and the 

consequence is a slower response of the cage in CaseStudy05 compared to 

CaseStudy04.  

 

Dynamic considerations are finished. Exit AquaView, the Analyse window and close 

AquaEdit.  

 

6.6 Summary 
In this case study you have investigated the effect lice skirts have on forces in mooring components. By 

adding impermeable tarpaulin, the axial forces will increase.  

 

 

 

--- End of document --- 


